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Chapter 4 

 

Virtual Instrumentation Software explored within the European project 

Virtual community Collaborating Space for Science Education 

 

 
Virtual instrumentation can be used for building applications which simulate real-world 

devices, structures and instruments operating, and for animation and modelling of the real 

processes. It’s not only a powerful tool to replace fixed, dangerous or expensive experiments 

but also a good complement to students’ work at real laboratory.   

 

CABRI GEOMETRY II 

 

IV.1. Educational Value and Limits of CabriGeometry II 

 

Cabri Geometry II constitutes a piece of educational software which is not limited 

simply to supporting an alternative approach to teaching with the use of computer, but which 

also supports the development of a dynamic, investigative and exploratory approach to the 

teaching and learning of Geometry. It comprises a set of powerful and carefully-designed 

computer-tools for the realization of a variety of interactive Geometrical activities. It also 

allows the student the possibility to construct and study their own geometrical objects, 

providing them with strong motivation to extend their knowledge of Euclidean Geometry.  

Cabri Geometry II features certain basic advantages in teaching and learning 

Geometry when compared to other existing educational software. In greater detail: 

- It consists of a set of tools and operations which allocate elements of high 

interaction; 

- It constitutes a dynamic learning environment, which means that the forms of the 

geometrical constructions produced on the computer screen can be altered while 

certain properties remain immutable. These constructions can be formed by using 

the tools provided by Cabri and can be directly manipulated by using the “drag 
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mode” operation provided. When such a geometrical construction is dragged, 

infinity of geometrical constructions with the same properties but different forms is 

visualized on the screen of the computer. In fact, each geometrical construction 

represents a class of geometrical constructions with common geometrical 

properties. By observing a plethora of geometrical constructions with common 

geometrical properties, students have the chance to form abstractions regarding the 

geometrical concepts in question (Laborde, 1990); 

- Student actions are mainly accompanied by visual feedback. The role of pictures 

has been reported as being significant in supporting the creation of mental images, 

which is considered essential in individual intellectual development (Sutherland, 

1995). It is also acknowledged that the interaction between geometrical concepts 

and geometrical figures can support the development of geometrical logic 

(Mariotti, 1995); 

- It is an open learning environment which allocates a plethora of tools to assist 

students in solving a variety of geometrical problems. The importance of problem 

resolution in the development of students’ mathematical thinking has been also 

reported (von Glasersfeld, 1987); 

- It provides the possibility to record step-step all the actions performed by the 

students when facing the given problems. This possibility constitutes a powerful 

tool not only for teachers and students but also researchers, enabling them to draw 

conclusions about the learning process that takes place in this environment. 

Consequently, it offers new possibilities for mediation between teachers and 

students; 

- It provides the opportunity to perform interdisciplinary activities by using the large 

variety of robust tools and operations presented in its interface. The importance of 

interdisciplinary approaches in teaching and learning has also been acknowledged 

(Noss and Hoyles, 1992); 

- Students can approach the geometrical concepts in question in a qualitative way; 

that is to say, without the use of numbers. Students can initially study the 

geometrical concepts in question qualitatively and subsequently move on to use 

more quantitative approaches; 
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- Despite the fact that Cabri Geometry II does not feature a system to check the 

correctness of students’ answers and solutions to the given problems, it provides 

tools which can be used for self-correction; 

- Cabri Geometry II does not remain a static environment but can also be developed 

simultaneously with the user. This development is possible through the creation of 

new operations (macros) which give this environment a dynamic dimension 

because it can be enriched with new tools produced by the user themselves.  These 

tools can be placed permanently, as new possibilities, in the interface of Cabri. By 

using these new operations, a geometrical construction can be automatically 

performed; for example, in a triangle constructed by a student, its heights and their 

intersection point could be automatically constructed by the system using an 

appropriately designed macro. 

 

IV.2. Basic Possibilities in Educational Use of CabriGeometry II 

Cabri Geometry II provides the opportunity to approach a variety of subjects 

concerning Euclidean Geometry. Basic issues of reference are as follows:  

- Analytic and Euclidean geometry as well as Geometrical transformations within a 

highly interactive environment; 

- Direct construction of points, straight lines, segments, triangles, polygons, circles 

and other basic geometrical shapes; 

- Translation, enlargement and rotation around a point as well as reflection, 

symmetry about an axis and around a point and inversion; 

- Easy constructions of conical surfaces, ellipsis and hyperbola; 

- Investigation of high level graphic representations related to probolic and 

hyperbolic geometry; 

- Annotation of numbers and measurements (with automatic record keeping); 

- Systems of both Cartesian and polar coordinates; 

- Equalities of geometrical entities can be demonstrated; 

- Macros of important or often-used geometrical constructions can be formed by the 

user; 
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- The teacher can work out lists of content, including the subjects in focus and of 

interest for their students; 

- Possibility of investigation of Geometrical properties in geometrical constructions 

based on the five Euclidean axioms; 

- Graphic determination of geometrical places; 

- Objects that are used for the geometrical constructions in question can be moved or 

hidden in order not to tax the computer screen; 

- The pallets of colours and lines facilitate the differentiation of forms; 

- The possibility for animation through electing the dynamic character of the 

geometrical constructions formed; 

- Geometrical constructions and macros can be stored in a hard disk; 

- Work surface of one meter square: this allows a drawing surface of 8 ½ × 11” to be 

printed. 

The philosophy behind Cabri Geometry is to allow the maximum interaction (mouse, 

keyboard, etc.) between the user and the software, and, in each case, to ensure the user is not 

surprised by the response of the software, firstly by respecting the standard responses of 

applications and operating systems, secondly by plausible mathematical behavior; 

A Cabri Geometry document comprises a free-form figure on a single sheet of virtual 

paper, 1 meter square. A figure contains geometrical objects such as points, lines, circles, etc., 

in addition to numbers, text, formulas etc. A document may also include macro-constructions, 

used in the simplified reproduction of constructions in a figure and to extend the 

functionalities of the software.  

The Cabri Geometry II screen consists of: 

- The standard menu bar; 

- The toolbar which provides all the tools needed for constructions; 

- Each icon corresponds to a tool and produces an extended toolbox if the mouse 

button is held down; 

- The properties bar on the left of the screen; 

- The colour palette which can be positioned anywhere on the screen; 

- The scrollbars for moving around the drawing area (a 1 meter square); 
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-  A diagram with measurements of area and length, and a calculation based on these 

numbers.  

Most of Cabri Geometry’s tools are accessed from the toolbar where the icons open 

different toolboxes (Figure 1).  

 

 
Figure 1 – Examples of Cabri Geometry’s tools  

 

IV.3. Cabri Geometry II Possible Teaching and Learning Activities and Applications 

 

a) Forming / verifying conjectures by focusing on the alteration of a geometrical 

construction using the drag-mode operation. For example, when a student draws a triangle 

ABC, its median AG and D, E, F, the midpoints of BG, AG and AC respectively, they can 

conjecture that “the quadrilateral DEFG is a parallelogram” and also verify this conjecture 

somehow formed during their experience (Figure 2(a)).  

b) Forming / verifying conjectures by focusing on the numerical data automatically 

collected during the alteration of a geometrical construction using the drag-mode operation. 

A case in point is when a student draws a rhombus ABCD and its diagonals AC and BD as 

well as their intersection point O, then automatically measures the angles ABD, DBC, BCA, 

ACD, CDB, BDA and BOC and tabulates the data automatically produced by the 

aforementioned measurement operations. By focusing on these numerical data, this student 
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can conjecture that “The diagonals of a rhombus are perpendicular and bisect its angles”. In 

this way, students can also verify conjectures somehow formed (e.g. using their visual 

perception) during their experience (Figure 2(b)). 

 

(a) (b) 

Figure 2 – Examples of (a) and (b) types of activities consisting of the proposed  

e-learning space 

 

c) Verifying a formula by focusing on the numerical data automatically collected 

during the alteration of a geometrical construction using the drag-mode operation. For 

instance, students can verify the generalization of the Pythagorean Theorem (Figure 3(a)). 

d) Multiple-solution activities. As Cabri provides a variety of tools and operations, 

these can be effectively combined to support the performance of multiple-solution activities. 

In the context of these activities, it is possible to integrate all the possibilities provided by 

Cabri into any of the possible different types of activities. For example, students could be 

asked to form pairs of similar triangles in any possible way using the variety of tools provided 

(Kordaki  and Mastrogiannis, 2006). Some of the possible solutions can be seen in Figure 

3(b).  

e) Black-box activities. Students can participate in activities where they have to 

explore geometrical constructions with some of their properties hidden, which they then have 

to discover.  To illustrate this, students can be asked to investigate the specific properties of 

the triangles illustrated on the computer screen (Figure 4(a)). It is worth noting that one pair 
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consists of arbitrary triangles while the other pair features similar triangles. Students can reach 

this conclusion by manipulating these pairs of triangles using the “drag mode” operation. 

 

(a) (b) 

Figure 3 – Examples of (c) and (d) types of activities consisting of the proposed  

e-learning space 

 

f) Constructions simulating real life problems. Such real life problems can help 

develop strong motivation to learn in students and encourage them to approach mathematics 

as a human activity (Bishop, 1988) as well as put mathematical concepts into an 

interdisciplinary context. As an example, let us consider the following problem: Two masts of 

a boat are 4 and 6 metres high respectively.  Cables connect the top of the first with the base 

of the other. The cables intersect at point E, which is 2.4 metres above the deck. How can the 

captain, moving the masts, add a third, 3 metre cable, to the intersection, so as to achieve 

better support of the sails? (Figure 4(b)).  
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(a) (b) 

Figure 4 – Examples of (e) and (f) types of activities consisting of the proposed  

e-learning space 

 

Example and pedagogical analysis 

 

Parallel Straight Lines Intersected By A Transversal 

 

Learning activity  

Construct two parallel lines e1 and e2 and then a transversal line e. Line e intersects 

lines e1 and e2 on points B and A respectively. Around these points, eight angles are formed. 

Could you define relations between these eight angles?  

 

File – New  

• Construct a line e1. (Key 3 - Line). Click on a point of the screen and drag the 

cursor.  

• Name the line e1.  (Key 10 - Label). Click on the line and, in the shown frame, 

press e1, on the keyboard.   

• Construct line e2 parallel to e1. (Key 5 - Parallel line). Move the cursor toward 

line e1, and then click on another point on the screen. Line e2 passes through this point. 

• Name line e2. (Key 10 - Label). Click on the line and, in the shown frame, 

press e2, on the keyboard.   
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• Construct a third, line e (transversal), which intersects lines e1 and e2. (Key 3 - 

Line). Click on a point of the screen and drag the cursor, so that e intersects these parallel 

lines.   

• Name the straight line e. (Key 10 - Label). Click on the line and, in the shown 

frame, press e, on the keyboard.   

• Mark the intersection points. (Key 2 - Intersection point). Click on line e1, then 

on e. In the same way mark the other point. 

• Name the intersection points. (Key 10 - Label). Click on each intersection point 

and, in the shown frame, press A, B on the keyboard. 

• Measure the eight formed angles. (Key 9 - Angle). Click on a side of the angle, 

afterwards on its vertex and finally on the other side. Repeat the process for all the angles 

formed. 

 

Investigation 

• Formulate conjectures based on the measurement of these eight angles. 

 

Generalisation   

• Tabulate the results of measurements. (Key 9 - Tabulate). Click on a point on 

the screen, where the table will be presented. From the bottom of the left corner of this table, 

drag and hold the cursor, until 8 columns are presented in the table. Click on the value of each 

angle, which is registered, automatically in the table.  

• Select and move the straight line e. (Key 1 - Pointer). Click and hold on the line 

and move it. 

• Automatic Tabulate. Each time that the straight line is moving, press the Tab 

key and the table, automatically, is updated.     

• Can formulate rules about the relations of these eight angles?  

 
Presence of investigation moments into an explanatory learning situation allow for transfer of 

knowledge into new settings and, thus, for acquisition of functional expertise.  
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IV.4. Bibliography for teachers 
 
Free Cabri Resources can be found on Internet: 

[1] The Cabri Geometry II Manual (http://www.chartwellyorke.com/cabrimanual.pdf); 

[2] Cabri Geometry II Started Guide (http://www.chartwellyorke.com/gettingstarted.pdf); 

[3] Exploring the Basics of Geometry with Cabri – some chapters from the book of Wilgus 

and Pizzuto (http://www.chartwellyorke.com/exploringbasics.html) 

 
 

CROCODILE CLIPS 
 
 

IV.5. Educational Value and Limits of Crocodile Clips 

 

Crocodile Clips is a set of simulation and modelling packages covering physics, chemistry, 

ICT and programming, design and technology and mathematics (Crocodile Physics, Crocodile 

Chemistry, Crocodile Mathematics, Crocodile Technology, Crocodile ICT&Computing). 

These software tools allow flexible experimentation in accurate virtual laboratories. So this is 

a virtual instrument that makes easy to create virtual experiments. These are flexible, 

powerful, accurate and can be used at all ages between 10 and 18 years old.   

 

Crocodile Clips has a smart interface than makes it appropriate for lower or upper secondary 

schools. There are even some uses in Primary Science. 

 

It covers a large part of secondary school curriculum subjects in Physics and Chemistry. Yet, 

the teachers who used it identified important subjects that can not be modulated with 

Crocodile Clips.  

 

IV.6. Basic Possibilities in Educational Use of Crocodile Clips 

 

Schools having a School Site License or using a free Demo, need the program to be installed 

at each computer. There’s neither player nor standard format file to be exported. So, students 

can build their own experiments or interact with those prepared by the teacher. 

http://www.chartwellyorke.com/cabrimanual.pdf
http://www.chartwellyorke.com/gettingstarted.pdf
http://www.chartwellyorke.com/exploringbasics.html
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Crocodile Physics is also a powerful tool at Digital Whiteboard. Some experiments can help 

teachers teaching bases or principles of Physics.  

Three kinds of Crocodile Physics users are: students who are solving and interacting with 

designed virtual experiments, students building their own experiments and teachers using 

digital whiteboard at classroom 

 

Welcome screen: The general view of the Introduction Menu is presented in Figure 5a. One 

click on the M button led to see and use the full screen mode (Figure 5b). Going back to a 

windowed mode at any time could be made by pressing again the M button.  

 

a) 

 
 

Fig. 5 – General view of Introduction Menu panel: a) the windowed mode 
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b) 

 
 

Fig. 5 – General view of Introduction Menu panel: b) the full screen mode 

 

During the designing of the virtual experiment, the Pause and Reload buttons can be used . 

The selected buttons can be used by pressing on them alternatively.  

 

Part trays are different for each topic (Figure7a). They can be used by drag in or drag out of 

the tray. For example, a ball dragged from the tray parts is illustrated in Figure 7b. The 

possible actions of the user with these part trays are always described in the bottom side of the 

application window. 

 

Another instrument can be introduced in the tray. The characteristics of this instrument could 

be set up by the user with the help of the Properties box. For example, a rod could be 

attached to the ball and its characteristics can be changed by using the Properties box (Figure 

8). 
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Fig. 6 – Use of Pause and Reload buttons during the virtual experiment design 

 

Properties can be related to different parts, i.e.: ball (velocity, x position etc.), rod (angle form 

the vertical etc.). 

 

a) 
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b) 

 
 

Fig. 7 – Use of Part Trays during the virtual experiment design 

a) general view of the needed parts; b) dragging in the tray of the needed part 

 

 

 
 

Fig. 8 – Use of Properties box during the virtual experiment design 
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IV.7. Crocodile Clips Possible Teaching and Learning Activities and Applications 

 

The using of Crocodile Clips Software components (Crocodile Physics, Crocodile Chemistry, 

Crocodile Mathematics, Crocodile Technology, Crocodile ICT&Computing) is made in the 

same mode as is depicted in the following sections. Due to the similar use of all the Crocodile 

Clips components, there will be described just examples concerning the use of Crocodile 

Physics component. Once the users were trained to use the Crocodile Physics application, they 

will be able to design virtual experiments also with the other components of the Crocodile 

Clips Software. 

 

Example and pedagogical comments 

 

Wave Experiments 

 

After this section the user will be able to set up a two dimensional wave experiment 

using sources, detectors, obstacles, etc.  

First of all, the module related to the waves experiments will be selected from 

CONTENTS>>INTRODUCTION menu (Figure 9). 

The user will be asked to set up the own experiment using the Optics folder (Parts 

Library). 

After that, the user has to drag on the line source and place it on the wave space (a 

point source or a moving point source can be added instead) (Figure 10). 
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Fig. 9 – Initial view of the Introduction menu (Waves section) 

 

 
 

Fig. 10 – Placing of the line source in the waves experiment 
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The properties of the line source can be changed by selecting the source and using the 

properties panel (last tab in left menu properties, as is illustrated in Figure 11).  

 
 

Fig. 11 – Setting up of the line source properties using the Properties Panel 

 

It has to be noticed that this menu refers to Line source properties. Selecting 2D Wave 

space (Figure 12), the properties are different (what liquid, depth of liquid etc.). 

      

 

Fig. 12 – Changing of the Properties panel settings function of the of the line source selected 
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By dragging the ends of the line source, this can be resized (Figure 13). 

 
 

Fig. 13 – Possibilities for resizing the line source 

 

A sloped block can be design by dragging on the sloped block tool in the experiment 

place (Figure 14).  
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Fig. 14 – Using of Sloped block tool 

 

By clicking on the block, its properties can be changed (from 10º and 0,4 cm height to 

20º and 1 cm height) as Figure 15 presents. 

Placing the pointer on the right of the 2D Space, a menu will appear (Figure 16).  

When the cross section button will be pressed, a red line will appear and at the same 

time a transversal view of the liquid surface will be shown (Figure 17). The change of the red 

line position will lead to a new cross section appearance in the box below (Figure 18). 

 

       
 

Fig. 15 – Changing of the Sloped block properties 
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Fig. 16 – The menu of the cross section button 

 

  
 

Fig. 17– Cross section button effect 
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Fig. 18– Changing of the red line position effect 

 

Exercises 

1. Open Parts library>>waves>>2D and set up an experiment using (at least): source, 

reflectors, cross section and detectors. 

2. Set up an experiment to teach Huygens Principle applied to a single slot. Vary with 

slot and wavelength to analyze different examples. Use cross section to represent them.  

 

IV.8. Bibliography for teachers 

 

[1] Electricity: 
http://www.crocodile-clips.com/shared/videos/cp/Electricity.html
[2] Alternating currents: 
http://www.crocodile-clips.com/shared/videos/cp/Alternating_Currents.html  
[3] Motion: 
http://www.crocodile-clips.com/shared/videos/cp/Motion.html  
[4] Pendulum and spring; Harmonic motion: 
http://www.crocodile-clips.com/shared/videos/cp/Oscillations.html  
[5] Ray diagrams: 
http://www.crocodile-clips.com/shared/videos/cp/Ray_Diagrams.html  
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[6] Waves: 
http://www.crocodile-clips.com/shared/videos/cp/Waves.html  
[7] Optics: 
http://www.crocodile-clips.com/shared/videos/cp/Optics.html  
[8] Using Crocodile Clips to teach Primary Science: 
http://www.mape.org.uk/curriculum/science/science14.htm  
[9] Discovering Electronics with Crocodile clips: 
http://www.doctronics.co.uk/DEtitle.htm

 

 

LABVIEW 
 
 
IV.9. Educational Value and Limits of LabVIEW 

 

LabVIEW (Laboratory Virtual Instrument Engineering Workbench), registered 

trademark of National Instrument Inc. (NI), is instrumentation and analysis software for PCs 

running.  It is programming environment including all of the tools necessary for instrument 

control, data acquiring, storage, analysis, presentation and integrating all of these features in 

one system. It uses graphical programming and a graphical language, called G. The main goal 

of LabVIEW is creation of the virtual instruments. 

Virtual instrumentation can be used not only for the real-world instruments building, 

what was noted above, but also can be useful for building applications, which simulate real-

world devices and instruments operating, and for animation and modeling of the real physical 

processes, e.g. physics experiments, to present how they run. This is one of the possibilities 

and significant characteristics of LabVIEW, which can be used to elaborate tools useful in the 

teaching process, also e-learning, for example, teaching fundamentals of the physics 

phenomena or to demonstrate methodology of physics experiments performing. 

 

 

 

 

 

 

http://www.crocodile-clips.com/shared/videos/cp/Waves.html
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IV.9. LabVIEW Basics 

LabVIEW programs, virtual instruments, have three main parts: the Front Panel, the 

Block Diagram, and the Icon/Connector. When you launch LabVIEW the start window 

appears, like this, for example, shown in Figure 19 for LabVIEW 8.2. 

 
Figure 19 – Start window for LabVIEW 8.2 

 
From the start window one can open the blank VI (empty; Figure 2) by selecting Blank VI 

from the box Files>>New. 

 

The VI is built with two windows, the Front Panel window visible at the front (Figure 20) 

after opening the blank VI and the Block Diagram window at the background, behind the 

Front Panel window. 
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These windows have the standard Windows features, such as a title and menu bars, scroll 

bars, minimize and maximize buttons, and also specific for LabVIEW additional features like 

the tools bar and the Icon/Connector box visible at the right, top corner of the VI windows. 

 
The Front Panel, user interface, allows user to control the VI execution. It is built up from a 

collection of graphical objects used by the user to give the VI some information (an input to 

the program) or used by the VI to give information expected to be useful for the user (an 

output from the program). The Front Panel objects, depend their role in the application, are 

Controls or Indicators. Controls supply application with data used to control it, and Indicators 

are used to present acquired data or results obtained after data analysis. For both types of the 

front panel objects are used common name Controls. 

 
Figure 20 – The front panel (at the front) and block diagram (at the back) windows 

One can place a front panel object on the front panel by opening Controls Palette by 

popping-up where wants in the front panel window, and selecting corresponding sub-palette 

(Numeric palette for example), and next the appropriate icon (Tank for example) placing on 

the front panel with the dragging and dropping technique (Figure 21). The Controls Palette 

can be also opened from the menu bar by selecting View>>Controls Palette. 

Chapter IV 24/73
 



 
VccSSe 

Virtual Community Collaborating Space for Science Education 
 

“Guidel ines for Best Pract ices in Educational Use of Virtual Instrumentation” 
 

 

 

Figure 21 – The front panel with Controls Palette 
 

 Figure 22 – The Tools Palette 

 

Once placed on the front panel the object (Tank) can be resized, labeled, named, 

ranges changed, colored etc. For these operations the corresponding tools can be selected from 

the Tools Palette (Figure 22). The Tools Palette can be opened from menu bar by selecting 

View>>Tools Palette or with key combination Shift+Right-Clicking. 
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Figure 23 – The front panel with the control which simulates a tank 

 

The Tools Palette is a graphical panel that contains various tools used to create and operate 

VIs. A tool is a special mouse cursor, which can be a different type depending its function, for 

performing specific operations such as positioning, wiring, labeling, operating, scrolling, 

setting breakpoints, probes and shortcut menus, and also operations usually used in a typical 

paint program for object view changing.  

 

Figure 23 shows the control Tank, which name was edited, by replacing Tank with Tank for 

B-M law, using the Labeling Tool.  With the same tool the Y axis scale name V [l] was placed 

and its range changed from 10 to 4. Text editing was made on the way typical for the 

programs used for text editing. Also the width and height of the tank were changed using the 

Positioning Tool. Finally the color of the space under the gas level in the tank was changed to 

white using the Set Color Tool, as well as, the background of the window. Operations 

connected to size and colors changing are performed on the way similar to operations typical 

for picture editing.  For changing the level of the gas in the tank one can use the Operating 

Tool. 
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The Tools Palette is common to both front panel and block diagram operations. 

 
Figure 24 – Boyle-Mariotte's law.vi front panel and block diagram placed on the screen side 

by side 
 

The Block Diagram contains terminals corresponding to the front panel objects, controls and 

indicators, as well as, functions, structures, subVIs, constants, and wires that carry data from 

one object to another. Functions, structures and subVIs are program execution elements – 

nodes. The sub-VI icon represents a program placed as a subprogram within another VI. The 

collection of listed above objects represents in graphical form the source code of the program. 

During program execution data are transferred between the Front Panel and the Block 

Diagram, and carried between icons on the block diagram. The path of the data flow on the 

block diagram is determined by wire connections. Figure 24 shows the Boyle-Mariotte's law 

.vi front panel with placed the numeric control named Volume, which a role is displaying the 

value of the gas volume with ml units and 1 digit precision. 

One can open the front panel and block diagram windows separately using instruction 

Window>>Show Front Panel or Show Block Diagram available on the corresponding menu 

bars. 
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Figure 25 – Properties selection for the front panel object – Volume control: a) shortcut menu 

of the Volume control, b) Numeric Properties window 

 

In the Boyle-Mariotte's law .vi program the numeric control Tank for B-M law supplies the 

numeric indicator Volume with numeric data. Changing of the Tank for B-M law indicator 

function into Tank for B-M law control function was possible by selecting Change to Control 

(Figure 25a) from pop-up menu available for the Tank for B-M law indicator. Opposite of 

Change to Control (function) is the Change to Indicator (function). Similar function changing 

is possible for other controls after placing them on the front panel. Controls are data sources 

and indicators are data receivers. Each object placed on the front panel is represented on the 

block diagram by its terminal. Depends on the object function its terminal border can be thick 

(for controls) or thin (for indicators). Data can be carried from the control terminal to the 

indicator terminal after connecting them by wiring with the Wiring Tool. 
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The properties of the control placed on the front panel can be determine from the Properties 

window (Figure 25b shows it for the numeric control Volume), which may be opened from the 

object pop-up menu by right-clicking and selecting option Properties (Figure 25a). From such 

window after opening Format and Precision option the 1 Digits of precision was selected for 

number displayed by Volume indicator.  

 
Figure 26 – The Multiply arithmetic operator selecting and dragging from the Express 

Numeric sub-palette and inserting between Tank for B-M law and Volume terminals 

 

Data can be modified on the way of its passing. On the block diagram in Figure 24a the value 

of liters of the gas received from the Tank terminal is converted into the value of the milliliters 

displayed by the volume indicator. Data modification is done with the Multiply function 

object inserted on the way between Tank for B-M law and Volume terminals. The function 

objects and VIs for data modification are available from the Functions Palette. One can place 
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a function object on the block diagram by opening the palette with functions and VIs 

(Functions Palette) with right-popping-up where one wants in the block diagram window, and 

selecting corresponding sub-palette (for example, Express Numeric sub-palette opened from 

Express>>Arithmetic&Comparison) and next dragging the appropriate icon (Multiply 

numeric operator, for example) to the block diagram window, and dropping (Figure 26). The 

Functions Palette can be opened also from the menu bar by selecting View>>Functions 

Palette. 

 

After source code completing you can run VI once by clicking Run button or continuously by 

clicking Run Continuosly button available on the tools bar. White Run button informs you that 

the VI is ready for running. If you run the VI, LabVIEW compiles it, and starts the VI 

execution. While the VI is executing the Run button changes appearance (by replacing the 

white arrow with the black one) for indicating that VI is running. You can stop VI execution 

immediately by pushing Abort Execution or Running Continuosly buttons available on the 

tools bar. 

 
Figure 27 – Programming errors debugging: a) VI with errors, b) window with error list 
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IV.10. Some LabVIEW Advanced Features 

 
Sub-VI creating - is recommended for the large program to select fragments of the VI code 

and create sub-VIs, what compresses the program and makes it more readable. For the sub-VI 

creating you have to select the respective fragment from the total code with the Positioning 

Tool, then click instruction Edit>>Create Sub VI, available from the Tool Bar. After sub-VI 

creating, it replaces the selected code fragment with a standard icon, which view can be edited 

using the Icon Editor available from the Tool Bar by selecting File>>VI Properties, then Edit 

Icon.... The sub-VI icon has some input and output terminals, which functions are similar to 

the pin functions in the connector of the real instrument. The sub-VI connector pane gives the 

possibility to pass data to/from the VI. Figure 28 shows the block diagram with to sub-VIs, 

Data modification.vi and Data for graph.vi. For Data for graph.vi the connector pane was 

shown by selecting Visible Items>>Terminals from sub-VI shortcut menu. 

 

Event structure has one or more sub-diagrams, or event cases, exactly one of which executes 

when the structure executes. The Event structure waits until an event happens on the front 

panel then executes the appropriate case to handle that event. In our application the Event 

structure is used to set to default the current values of the selected objects placed on the front 

panel.  After The Event structure placing on the block diagram and adding new case you have 

to select the front panel object, which should belong to added case. For this you can use the 

Edit Event window, which appears automatically after new case adding. In this window you 

have to click the name of the control, which should belong to added case, then select the type 

of the event, which will cause execution of the selected case. In our application, value 

changing of the Set to defaults control, after control clicking, caused execution the “Set to 

defaults” event frame, and setting the default values for selected controls (Figure 29). The 

corresponding objects are represented in the Event Case by property nodes or Local variables, 

to which default values are wired. 
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Figure 28 – Boyle-Mariotte’s law 10.vi, with some LabVIEW advanced features: a) user 

interface, b) block diagram window 
 

Local variables represent front panel object in several locations on the block diagram. You 

may use them to pass data between structures that are not connected by a wire or update the 

front panel object from different locations on the block diagram. You can create a local 

variable for selected objects from its shortcut menu using Create>>Local Variable 

instruction. After creating a local variable for selected object it appears as a rectangle box 
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with the object name inside. For each object placed on the front panel you can create several 

local variables. Some of them can be changed to write, other can be changed to read, depend 

their function in the code by selecting Change to Write or Change to Read function. 

 
Figure 29 – The Event Structure: a) shortcut menu, b) Edit Events window 

 
Figure 30 – The final version of the Boyle-Mariotte’s law application 
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Local variables represent front panel object in several locations on the block diagram. You 

may use them to pass data between structures that are not connected by a wire or update the 

front panel object from different locations on the block diagram. You can create a local 

variable for selected objects from its pop-up menu. After creating a local variable for selected 

object it appears as a rectangle box with the object name inside. For each object placed on the 

front panel you can create several local variables. Some of them can be changed to write, 

other can be changed to read, depend their function in the code. 

 

IV.11. LabVIEW activities and examples 

Application Building for Boyle-Mariotte’s Law Demonstration 

For Boyle-Mariotte's law demonstration you have to implement the following equitation 

p0V0 = p1V1 for   T = const,    (1) 

and next present how the pressure p of the ideal gas depends of the gas volume V, when the 

gas temperature T1 is constant and normal 

p1 = p0 V0/V1  for   T0 = 293.    (2) 

 

To demonstrate this law you have to simulate compressing process forced by the 

external force F applied to the piston, what results on the gas volume changing. It means that 

you have to build the VI, that consists the numeric control representing the influence of the 

force F on the gas volume V, the numeric indicator Tank for B-M law, and two numeric 

displays, V1 and p1 (Figure 31a). For this purpose you can use the VI, early built, presented in 

a figure above. In the simplest version of the VI for the Boyle-Mariotte’s law demonstration 

the Slide named V(F) can be used for simulation of the force F influence on the volume V 

changing. You can decide that the slide V(F) will change the gas volume V from Vmax = 2,7 

liters to Vmin = 1 liter, what means that it has to flow numeric data to the Tank for B-M law 

selected from the range limited by 2,7 and 1 numeric values. If so, you have to select the 

respective range for the slide V(F) after opening its Properties window (Figure 31c). Also its 

scale inverting is needed. After slide V(F)  configuring we you to change this time the Tank 

for B-M law function from write to read. 
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 Figure 31 – The simplest version of the Boyle-Mariotte’s law demonstration: a) VI front 

panel, b) VI block diagram, c) window for slide V(F) configuring 

From Functions>>Decorations palette one can drag an arrow and place it under the 

piston for indicating the force F direction influence. For displaying the current values of the 

volume V1 and pressure p1 are used numeric indicators V1 and p1. After described operations 

performing the Boyle-Mariotte's law 0.vi is ready for virtual measurements performed for 

normal temperature T0 = 293 K. The simplest implementation of the equitation (2) is 

presented in Figure 31b. 

 

Figure 32 – The Boyle-Mariotte’s law 0.vi with XY graph: a) front panel, b) block diagram 
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More advanced application should allow to present data as a collection of points (for 

example 10 points) placed on the XY graph. It means that the VI presented in Figure 11a 

should be reached with XY graph indicator. The resized VI front panel with XY graph labeled 

p(V) is shown in Figure 32a. One can select and drag the XY graph from the 

Controls>>Graph palette. After placing the graph on the front panel one can configure it, 

after opening its Properties window, in the way like this described above for the numeric 

control. The block diagram after graph placing on the front panel is shown in Figure 32b. As 

usually, after the graph indicator placing on the front panel the corresponding graph icon 

automatically appeared on the block diagram. 

A. Programming Structures 

For application improving by data presentation on the graph, we need to have the 

collections of the point coordinates, which should be placed on the graph. If so, we have to 

replace the slide V(F) with a sub-program, which will prepare automatically the value Vi (xi 

coordinate) for each p(V) point (yi coordinate) of the needed points set and build arrays 

consisted the collections (Vi) and (pi) of x and y coordinates of the points to be placed on the 

graph. Precisely, it means that we have to build two arrays with V1 and p1 data collections. For 

this purpose we can use the For Loop structure, one from the set of structures available in the 

LabVIEW environment. 

The basic set of the programming structures, shown in Figure 13 (available after 

selecting  Functions>>Programming>>Structures), are program control nodes, such as 

Flat/Stacked Sequence structures, Case structure, Event structure, For Loop, or While Loop. 

Structures can execute code repeatedly or conditionally. The structure creating technique is 

shown on the top left-hand side in Figure 33. They are not created on the block diagram 

immediately after selecting and dropping. Instead, a small icon representing structure appears 

on the block diagram, giving the programmer opportunity to size and position it to encompass 

all the objects need to be placed inside the structure and then executed within it. 
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Figure 33 – The basic set of the programming structures 

 

The For Loop executes the code inside the borders N times, where N is the value wired 

to the Loop Count terminal N. The Loop Iteration “i” terminal contains the current number of 

the completed loop iteration. 

After explanation of the For Loop function and how it executes, we can modify the 

source code on the block diagram shown in Figure 32b, for improving the application used for 

the Boyle-Mariotte's law demonstration. First we have to create the For Loop using the 

technique presented in the Figure 33, wire the numeric control terminal contained number of 

iterations (number of points to be placed on the graph) to N terminal, then prepare the code, 

which will supply the program with the numeric value, decreased automatically in every 

iteration of the For Loop, when it executes, and corresponding to the value of the gas volume 

in the tank. The slide V(F) was removed because it is not needed anymore. Instead, the 

Number of points numeric control, responsible for the number of points suspected to be visible 

on the graph, was placed. 
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Figure 34 – The improved Boyle-Mariotte’s law 1.vi: a) front panel, b) block diagram 

 

For small programs the area of the monitor screen can be split into two parts, for 

example, on the top for the front panel presentation and on the bottom for the block diagram 

presentation, in short, for displaying the front panel and the block diagram windows one under 

second. For this the instruction Window>>Tile Up and Down was used for the front panel and 

block diagram common presentation on the screen (Figure 34). Figure 24 shows the front 
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panel and block diagram windows placed side by side after selecting Window>>Tile Left and 

Right. 

For arrays building tonnels are used, which appeared after wiring the data sources (for 

examples the points wired to the inputs of the p1 and V1 terminals) to the For Loop border in 

the places shown by Wiring Tool. The arrays with p1 and V1 values collections before sending 

to p(V) graph terminal have to be clustered, what can be done with the Bundle operator. 

Now, after point number selection you can run the improved VI, the Boyle-Mariotte’s 

law 1.vi, record data, and present them on the graph. Using Highight Execution mode you can 

check the sequence of the operations during data recording, and finally, plotting the p(V) 

curve on the graph. 
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GEOGEBRA 

 

This free software application, General GNU Public License, has been developed by Markus 

Hohenwarter, from the University of Salzburg (Austria). It combines the benefits of the 

dynamic geometry software with those of the algebraic calculation systems. The GeoGebra 

objects are dynamically considered under these two aspects -graphical representation and 

analytical definition. 

 

The last stable version -GeoGebra 3.RC1 (Release Candidate- can be downloaded from the 

Website of this software: http://www.geogebra.org and, whenever possible, the WebStar 

versions in the already mentioned website (WebStar) can be used to ensure the usage of the 

last stable release. 

 

IV.13. First steps and applications with GeoGebra 
 

IV.13.1. Document window  

To start the GeoGebra application double click on the corresponding icon in the desk 

 Or follow the path: Start  All Programs  Geogebra  Geogebra. 

 

Figure 35 – Start GeoGebra 

You can do it either ways to get to the application window where the basic elements 

have been remarked: Toolbar, Input field, Algebra window and Drawing pad. 
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Figure 36 – The basic elements of the GeoGebra application 

To Hide/show the axes, select the command Axes from the View menu. 

By selecting one of the modes in the tool bar you can do constructions on the drawing 

pad. Coordinates or equations of the objects appear in the algebra window. 

In the input field you can write coordinates, equations, commands and functions that 

are displayed at the drawing pad after pressing the Enter key (or equivalent). 

 

IV.13.2. Representation of points 

 Click on New Point button. Place the cursor on the drawing pad and left click. Point A 

is displayed as represented here: 
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Figure 37 – Representation of points 

The last selected mode remains active until another one is selected, that is to say, if we 

scroll the mouse and left click again a new point will be created. The two arrows on the top 

right area (tool bar) allow us to undo  or redo  the last actions. 

 

IV.13.3. Change name 

GeoGebra assigns names to the objects alphabetically. In the case of the points: A, B, 

C… 

To change the name of an object: 
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Click on Move button. 

Place the cursor on the object and right click. 

In the context menu select 

Rename 
 

In the Rename window, type the new name 

of the object and press the  key. 

In this case we have changed the point A to Andrés. 

 

IV.13.4. Modify properties 

As it can be seen in the previous picture, after right clicking on an object, the context 

menu with several commands is displayed. The last one,  Properties … allows access to 

all the properties of an object. 
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Figure 38 – Modify properties 

Let’s change the colour and the size of that point. 

To change the colour, click on the  tab and choose a new one by clicking on 

the suitable cell. To finish, click on the button . 

 

 

Figure 39– Change the colour 
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To change the size of the point, click on the  tab and move the slider until the 

measure you want. To finish, click on the button . 

 

Figure 40 – Change the size of the point  

After the described modifications, the appearance of the point renamed as Andrés is 

presented this way: 

 

Figure 41 – The appearance of the point Andrés 
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IV.14. Introduction drill 

The image shows a height (in meters) - weight (in kilograms) graph corresponding to a 

group of 5 friends as it can be seen in the records made due to a check-up (notice the lack of 

reference to the interruption of the axes). 

Look at the chart from the Figure 41 and answer the following questions: 

- How tall is Alberto? 

- Which is Mónica’s weight? 

- Who is the shortest person? And the tallest? 

- Who is the most obese person? And the thinnest? 

- How tall is David and which is his weight? 

- What happens if we join the points? 

- Do you find the axis scale appropriate? 

 

Figure 42 – Exercise  

IV.15. Basic commands 

Our goal is to get a representation similar to the previous one. We have already 

explained how to start GeoGebra and how to change a point’s colour, size and position. 
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Let’s see now how to change the background colour, the axis colour and the grid 

colour, insert a text and modify its properties, and how to hide the algebra window so that the 

entire window will be occupied by the drawing pad. Besides, we will describe the way to 

export the constructions to html format. 

For that, we will modify a GeoGebra file, which we will save later. 

 

IV.15.1. Open a file 

To open a file we can: 

 select the command Open… from the File menu, in case the application is already 

started, or, 

 double click on the name of the file. 

 In either ways, we try to open the activ01.ggb file. 

 

Figure 43 – Open a file 
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Figure 44 – A GeoGebra file 

If the grid is not visualized, select the command Grid from the View menu. 

 

IV.15.2. Hide elements 

Let’s hide the elements that, in this moment, are not going to be used (algebra window 

and edit line or input field). 

To close the algebra window: Select the command Algebra window from the View 

menu. 

To hide the input line select the command Input field from the View menu. 

The ticks  shown in the image, in these items, must disappear. 
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Figure 45 – The View menu 

IV.15.3. Background colour 

To change the background colour: 

 select Drawing Pad… from the Options menu 

 or, place the cursor on any free area (from the drawing pad), right click and choose 

 Properties. 

a
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Figure 46 – a) Options menu and b) context menu 

In the Drawing Pad window, click on the Background colour button and proceed as in 

the case of the points (First steps). 

 

 

Figure 47 – The Drawing Pad window 

 

Figure 48 – Change the background colour to green 
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IV.15.4. Axis colour 

To change the Axis colour: 

 select Drawing Pad… from the Options menu 

 or, place the cursor on any free area (from the drawing pad), right click and choose  

 Properties. 

aa))    bb))    

Figure 49 – a) Options menu and b) context menu 

In the Drawing Pad window, click on the Colour button and proceed as in the 

previous case. 
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Figure 50 – The Drawing Pad window. The Axes tab 

  

Figure 51– Change the axis colour to green. 

IV.15.5. Grid colour  

To change the grid colour proceed as in the previous cases until visualising the  

Drawing Pad window. 
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Click on the  tab, and then on the Colour button and proceed as in any of the 

previous cases. 

Change the grey colour to dark blue. 

 

Figure 52– The Drawing Pad window. The Grid tab 

IV.15.6. Save a file 

To save a file: 

 Select the command Save from the File menu to save it with the same name, 

or, 

 Select the command Save as… … from the File menu, to save it with a different 

name. 

 Save the file with the modifications made up to that moment with the name 

activ01_01.ggb. 
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Figure 53 – Save a file 

 Change the name, colour and size of the points so that they are similar to the figure in 

the introduction drill (to copy the shape of a point you can use the command 
 
Copy 

visual style – last button in the tool bar) and save the new file with the previous name 

(activ01_1.ggb). 

 

IV.15.7. Texts 

 To insert a text you have to use the Insert text tool (penultimate button in the tool bar). 

Once selected, place the cursor on the drawing pad and left click. 

The Text window appears in the one we have to type the corresponding text and click 

on the  button. 
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Figure 54 – The text window 

To complete the introduction drill we still need the texts 1.80 in the X axis and 80 in 

the Y axis. We type the texts (place the cursor, nearly at the same height that the already 

existing ones) and then, we modify its properties so that the style will be similar to that of the 

original figure. 

We can use the Copy visual style tool, above mentioned, to copy some of the features 

in the existing texts. Once this operation is made, we place the cursor on the text, right click 

and in the context menu (Text T13) we choose  Properties. 

 

 

Figure 55 – The Properties window  

In the Properties window, we select  tab and we deactivate the Absolute 

position on screen cell. 
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In the Starting point field we write the coordinates of the text, (6.8, -0.5) and click on 

the  button. 

We repeat this operation with the Y axis. The coordinates in this case will be (-0.5, 7). 

 Save the new file with the name activ01_2.ggb. 

IV.16. Export  

GeoGebra allows to export the constructions (the drawing pad or just a part of it) as 

graphics formats (png, eps, svg, emf), copy them in the Windows clipboard and turn them into 

an interactive html page. 

 Open the last saved activ01_2.ggb file in the previous session, 

or 

 the solution file activ01_2Sol.ggb. 

It must look like the following figure: 

 

 

Figure 56 – The activ01_2Sol.ggb file 

The export menu is activated by the command Export from the File menu. 
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Figure 57 – Export a file in  GeoGebra 

By selecting the Drawing Pad as Picture (png, eps) … option, the drawing pad is 

copied in a chosen file. 

The Export: Drawing Pad window allows to choose the format from the output file 

(png, eps, svg, emf), the scale and the resolution (only in the case of png format). 

 

 

Figure 58 - Export: Drawing Pad window 
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By clicking on the  button we get to the Save window, where we can choose 

the name and placement for the output file. 

 

 

Figure 59 – The Save window 

The Dynamic Worksheet as Webpage (html) … option allows generating an html 

file which contains the construction and, at the same time, the movement of the free objects. It 

is possible to activate the application through a button and to allow the execution of the full 

program by double clicking on it. 

In the window Export: Dynamic Worksheet (html) we can write the title, author and 

date on the corresponding fields which will appear as head and footnote of the html file. It is 

also possible to include a text above (Text above the construction) and after (Text after the 

construction) in the application window and to include html code in them. 
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a)  

b)  

Figure 60 – The Export: Dynamic Worksheet (html) window. a) Advanced tab, b) General tab 
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The radio button Button to open application window with construction allows hiding 

the visualization of the construction until this button is pressed. 

The  tab allows choosing among the program options available for the user. 

If the Double click opens application window cell is activated, the double click on the 

construction in the Web page generated allows to open GeoGebra with the same features that 

the Windows application. 

In any case, several files are generated. If the name of the file is activ01_03.html, the 

files activ01_03.ggb, geogebra.jar, geogebra_cas.jar, geogebra_export.jar, geogebra_gui.jar, 

geogebra_properties.jar. are kept in the same folder. 

 

IV.17. Representation of the points  

1. In the following figure you can see the representation of the point P (3, 2). 

Remember that the first number, the abscise or x-coordinate, is represented on the horizontal 

axis (abscises); to the right of its origin if it is positive and to the left if negative. However, the 

ordinate or y-coordinate, the second number, is represented on the vertical axis (ordinates); 

above its origin if positive and below if negative. 

 

Figure 61 – Example 
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If you drag the point P with the mouse you can see how the coordinates change. You 

can check that if the point is in the first or fourth quadrants, the x-coordinate (abscise) is 

positive, but if it is found in the third or in the second, the x-coordinate is negative. As regards 

the y-coordinate (ordinate), it is positive for the quadrants first and second and negative when 

the points are in the third or fourth quadrants. 

 

2. The following figure has 4 points: two in the first quadrant, B and D, and two in the 

second, A and C. The thing is to drag the points in such a way that there is one per quadrant 

regarding the attached table: 

Point Quadrant

A 1 

B 2 

C 3 

D 4 

 

 

Figure 62 – Example 

Chapter IV 61/73
 



 
VccSSe 

Virtual Community Collaborating Space for Science Education 
 

“Guidel ines for Best Pract ices in Educational Use of Virtual Instrumentation” 
 

 

Complete now the following table: 

Point Sign of x Sign of y

A   

B   

C   

D   

 

IV.17.1. Dragging objects, segments, texts 

Let’s see how to make drills as the ones described in the previous paragraphs. We 

already know how to represent points and to change their names. Let’s see now how to limit 

their movement. We will explain later the way to define segments and to add texts with 

properties dealing with the existing objects. 

 

IV.17.2. Restraint the dragging to the grid 

 We open the activ02.ggb file, which already has the labelled axis and it is placed 

in the centre of the window. The thing is to incorporate a point P, which can be dragged with 

the mouse and whose coordinates are to be shown together with the name, to present the 

corresponding segments to the abscise and ordinate values (see figure in Representation of the 

points, drill 1). Besides, we want this dragging limited to the points of the quadrant. 

Let’s remember the way to define a point: Choose New Point, drag the cursor to the 

estimate position (3, 2) and left click. Change the name, size and colour until it looks like the 

original figure in this activity (see First steps). 

To limit the dragging of the points to the grid we have to select the command Point 

capturing from the Options menu and choose on. If we drag now the point P we’ll see that 

when it is close to any of the points on the grid it is attracted by it. If we want it to jump from 

one point on the grid to another without allowing any mid-positions, we have to select on 

(Grid). 
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Figure 63 – Selecting On the grid 

We can deal now with the distance between the units of the X and Y axis together with 

the ones defined for the grid. The definition of these distances is made in the  Properties  

window in the Drawing Pad (see First steps). 

The distance between the X and Y axis is set by default at 2 units and the distance 

between the points on the grid at 1 for both axis. If we want the points on the grid to be 

correspondent with 0.5 unit intervals, we will have to write that value in the unit field in the 

 tab. 

Let’s see these considerations with two figures. The one on the left shows the window 

without the grid, whereas the one on the right with the 0.5 distance grid. If we have the on 

option (Grid) selected, the point P will change its coordinates in 0.5 unit intervals in both axis. 
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Figure 64 – Example 

IV.17.3. Show the coordinates of one point 

If in the Properties window of the point P, in the field Show label (in the  tab), 

we select Name & Value, the P label adopts the shape we can see next in the image. 

 

 

Figure 65 – Show the coordinate of one point 
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Another possibility is to hide the label (deactivate the Show label cell) and insert a text 

in the position of the point. That way we can get texts different in colour and printing to those 

in the point. 

We define a text (see First steps) writing “P“ + P. What it is under quotation appears as 

it is; GeoGebra substitutes the P that follows + for the value of the point (in this case its 

coordinates). Then, in the Properties window, click on T1 (in the list of objects),  tab, 

and select bold ( ). 

 

 

Figure 66 – Define a text 

 

Figure 67 – The Properties window 

In the  tab choose a green shade and, finally, in the  tab deactivate the 

Absolute position on screen cell. 
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Figure 68 – The Properties window. The Position tab 

IV.17.4. Coordinates of a point 

In the last figure it can be seen, in the Starting point field, a chunk of the original 

expression: 

(x(P)) + 0.25, y(P) + 0.25) 

x(P) is the value of the x-coordinate of the P point and y(P) corresponds to the value of 

the y-coordinate. These are dynamic values, that is to say, the values change regarding the 

position of the P point. 

 Save the file as activ02_01.ggb. 

 

IV.17.5. Segments 

The only thing left is to lay out the segments corresponding to the coordinates of the P 

point and put the appropriate labels. 

 We choose the Segment between two points tool (third button to the left in the tool bar). 

We draw the segment between P and the X axis, corresponding to the ordinate. In order to get 
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this segment to always show the value of the ordinate, we have to modify its properties (right 

click on the segment and choose ) and assign the point (x(P), 0) as its end. 

Next, we can delete the point A drawn by the program to lay the segment out. 

 

Figure 69 – The Properties window 

And the same way to draw the segment corresponding to the y-cooordinate. In this 

case the ends will be P and (0, y(P)). 

In a similar way to the insertion of texts in the case of the point P, we can insert the 

labels of the segments (to show xP you have to write x_P). 

 

IV.17.6. Text with parameters 

 With the cursor surrounding the segment a, we choose the Insert text tool 

(penultimate button in the tool bar) and we write 

“y_P = “ + y(P) 

Remember that what it is under quotation will appear in the same way (but for the 

subscript) and the expression under after + is replaced by the value of the object y(P), that is 

the y-coordinate of the point. 
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Figure 70 – The Properties window 

And the same holds good for labelling the segment corresponding the x-coordinate. 

Remember that in order to drag the text with the point you have to deactivate the 

Absolute position on screen cell and write in the Starting point field the corresponding 

coordinates (that must make reference, in any way, to the coordinates of the point). 

 Save the file as activ02_02.ggb. 

 Use the command Export (see Export) with the option Dynamic Worksheet as Webpage 

(html)… and save the generated file as activ02_03.html. Open it with your browser and check 

how it works. 

 Reproduce drill 2 at the beginning of this section. Save the file as activ02_04.ggb. 

 Use the command Export (see Export) with the option Dynamic Worksheet as Webpage 

(html)… and save the generated file as activ02_05.html. Open it with your browser and check 

how it works. 

IV.18. Algebra window 

In the previous exercises we disregarded the algebra window. Let’s see now the 

information and the edition possibilities this window provides. 
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To open the Algebra window, click on the command named the same in the View 

menu. 

The attached image corresponds to the exercise described in Represent and drag 

objects. 

As you can see, there’s a free object, the point P, and two others dependent, the 

segments a and b, built to represent the x-coordinate and the y-coordinate of the point P. 

 

 

Figure 71 – Example 

The same considerations already mentioned dealing with the context menu in the 

Drawing Pad hold good for the algebra window. For instance, if we place the cursor on the 

point P, in the Algebra window, and right click on it, we reach the context menu 

corresponding that point. 
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Figure 72 - The context menu of the P point 

Any change made on any of the two windows immediately occurs in the other. So, for 

instance, the dragging of the point P to a new position causes the corresponding change in the 

algebra window regarding the definition of P and the measure of the segments. And 

reciprocally, all changes made in the algebra window are translated into changes in the objects 

represented in the drawing pad. 

 

Figure 73 – Example 
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IV.19. Construction Protocol… 

By selecting the command Construction Protocol… from the View menu, the 

Construction Protocol window is displayed where all the existing objects appear. 

In the View menu of this window we can choose the fields listed there. 

 

Figure 74 – The Construction Protocol… 

 

Figure 75 – The Construction Protocol… 

And with the arrows in the lower part of the window, we can regenerate the building 

from the very beginning, step by step. 

The command Export as Webpage (html) in the File menu in this window allows us to 

export this protocol and decide whether to include the drawing of the construction or not. 

This command is the same we had previously seen, command Export in the File menu. 

Chapter IV 71/73
 



 
VccSSe 

Virtual Community Collaborating Space for Science Education 
 

“Guidel ines for Best Pract ices in Educational Use of Virtual Instrumentation” 
 

 

 

Figure 76 – The Export as Webpage (html) window 

The next figure shows how this export browser looks like. 

 

 

Figure 77 - The export browser 
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IV.20. Export 

Before, see Export, we mentioned that the use of this command to obtain a Web page 

generates several files. For instance, if the html file is named test.html, this one is also created 

unless the test.ggb file already exists. 

Well, to modify the test.html file regarding the geometric construction, you only have 

to modify and save with the same name and in the same folder the test.ggb file. You can get 

this file from the browser if the option Double click opens application window is selected by 

default; otherwise you can open it from GeoGebra provided it is accessible in your computer. 

Another possibility is to re-export the construction again, once all the proper changes 

have been made. But if we have made unrelated modifications with the construction in the 

html file (add and/or modify texts and/or graphics…), those will be lost with the new export. 

Due to this considerations, when we have to open an html file that contains a 

GeoGebra construction, and we want to save it with a different name, we will have to follow 

the next steps: 

1. Open the html file (let’s suppose that it is named test.html). 

2. Open the GeoGebra construction by double clicking on the corresponding window. 

3. Export the file with a different name (for instance, testNuevo.html). 

4. Make the proper changes in the GeoGebra file and: 

… Save it as testNuevo.ggb in the same folder that testNuevo.html, 

or, 

 Export the new construction with the same name testNuevo.html. In this case, the file 

testNuevo.ggb is automatically created. 

 

IV.21. Bibliography for teachers 
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